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NanoEngineer-1 Tutorial

The Basics

Here is the opening screenshot of the program you will be working with: NanoEngineer-1. If
you have ever worked with a CAD program before, you may note some similarities in design
and layout. Open NE-1 either by double-clicking the shortcut on your desktop or through Start
Menu: Start = Programs = NanoEngineer-1 Alpha 9 = NanoEngineer-1.
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Figure 1 — NE-1 opening screenshot
There are several basic areas to the NE-1 window.
1. There are three toolbars at the top of the screen.

a. Drop Down Menus — these contain some of the most basic (Save, Open, Close,
Save As, Cut, Copy, Delete, etc) functions as well as the more specific functions
(ones that allow you to change the views, minimize energy, arrange the atoms,
etc.) Please take note of the Help Menu, where you will find a “What’s This?”
cursor. “What’s This?” allows you to click on an item or button in the NE-1
window and a little pop-up box with an explanation will appear, often with a link
to the NE-1 online Wiki which will contain more extensive information than the
pop-up box.

b. Icon Bar 1 — Everything in the icon bar can also be found in the drop down
menus. The icon bar simply puts the functions where they are more readily
available.



c. Icon Bar 2 — All the tools and functions that will allow you to build and
manipulate nano and DNA structures and run molecular dynamics simulations.
Clicking on the purple icon (the four left buttons) will open the gray icons (to the
right.)
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Figure 2 - Toolbars
2. Tabbed Menu Bar. This is along the left side of the screen. The first tab is the main
menu that shows every item present in your nanostructure. The second tab is a tools
menu, that allows you different options for the tool you are currently using.

3. Construction Window. This is the big blue (or white) area taking up most of your
screen. This is where you actually construct the nanomachine or molecule you are
working on. An excellent little feature of the construction window is the coordinate
axes in the lower left corner. When you rotate the screen, the coordinate system
rotates with you, so that you always have a defined system.

4, Action Log. The action log along the bottom of the screen records every activity that
you have taken in NE-1, including saves, deletes, chunk separations, opening of files,
closing of file, etc.

NE-1 File Types

Files created in NE-1 have the extension “.mmp” which stands for Molecular Machine Part. This is
the file that contains the original machine part and all the positions and information about the structure.
When you save a file, this is the one that the program creatres.

Simulation files have a “.dpb” extension. The program automatically saves these files when you run
a molecular dynamics simulation. They are a type of movie file that can only be played in NE-1. It is
possible to create movies that are playable outside of NE-1 by using an animation program that will take
screenshots of the simulation, but it is difficult and time consuming.

Your two best friends: Save and Undo
Meet the two most useful buttons in the program:

Save — saves your work. Use Save As if you want to save modification to a file without
overwriting the original file.

Undo — allows you to back up and undo what you just did. This is a great button because if
you make a mistake, you don’t have to start over from scratch.



Projects

In this tutorial, you will learn to construct simple molecules, as well as use tools in NE-1
called “jigs” that allow you to make measurements. You will also learn how to change the view
of the molecule and alter the bond type.

Exercise 1 - Building Simple Models and Making Angle Measurements
Construction of H,0
Steps:

1. Open NanoEngineer-1
2. Select the Build button from icon bar 2, and then the Atoms

2 button. When you do, a panel will pop up on the tabbed menu x

s | DAr with the title “Build Atoms.” Scrolling Down will reveal a sub- __
section called “MMKit,” (see figure 3) which will let you select bl = |
different atoms and bond types. The picture above shows the 8 Jlgfn o F v
atom as it appears in the NE-1 construction window. A
Build an H,O molecule. First, select oxygen (O) from the MMKkit \[i

AN

Force to Keep Bonds:

window. Then double-click in the construction window to place

the atom. Note the two red ends on either side of the atom.
Figure 3

F

These are open bonds. To complete the molecule, select

=] .

hydrogen (H), and single-click on the open bonds in the
construction window. You should now have a completed H,0

molecule (figure 4).
4. There are several options for viewing the molecule. All of the

options are in to the far right of the icon bar 1 at the top of the Figure 4
construction window. They can also be found in the drop-down

menu View > Display. Click and hold on the white background of &

the construction window and drag the mouse over the molecule 1 [31 |: N F_\J

to select all the atoms. You can also select the atoms individually
by clicking on them. YOU MUST HAVE THE ATOMS BUTTON
ACTIVATED TO SELECT ATOMS. To select more than one atom,
hold down the shift key while clicking. Then choose a different

Figure 5

display mode by selecting one of the display buttons along the top of the screen. Figure 4 shows
the molecule in Tubes and CPK (space filling model). Play around with the different options.
Also, you can rotate the molecule and change the view by using the buttons right next to the
display model buttons. Experiment until you become familiar with the procedure for
manipulating molecules. Before you continue, put the molecule back in tubes view, because that
makes it the easiest to work with.

5. Now add an angle jig to the molecule. Select all three atoms in the molecule. You must select
them in order (H-O-H) Select Simulation = Measurements = Measure Angle. This will add an
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6.

angle measurement jig to the molecule (figure 5). The readout of the angle measurement can be

moved so that it is easier to read. Just click on the numbers and drag.
Save the molecule

Construction of Ethene

Steps:
1.

4.

Construct an ethane molecule (figure 6.) Begin by using two sp3
carbon atoms. Add two hydrogens to each carbon.

Add a dihedral angle jig, by selecting the atoms H-C-C-H, then
clicking Simulation > Measurements - Measure Dihedral. The
dihedral angle is the angle between the two planes defined by the
four atoms (figure 7). The first plane is defined by H-C-C and the
second plane by C-C-H. Record the angle.

Construct an ethene (figure 8) molecule by converting the C-C
single bond to a double bond. To make the double bond, select the
bond between the two carbon atoms. Right-click on the bond and
then select “double bond.” Now make another dihedral angle
measurement. Record the angle.

Save the molecule.

Practice

el

1.
2.

3.

Open a new file.
Construct the below molecules, all in the same window.
a. Methane: CH,

b. Ethyne: H-C=C-H (there is a triple bond between the two
carbons)

c. Ammonia: NH;
d. Cyclobutane: C4H;
e

Figure 7

Figure 8

Cylcobutane with a methane molecule substituted for one of the hydrogens.

f. 3-bromo-1-propanol: HOCH,CH,CH,Br
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Figure

Minimize the energy on all structures. Click the energy minimization button. This will minimize
the energy of the bonds and move the atoms so that all the bonds are the correct length. Once

the Minimize Energy box pops up, click “Minimize Energy.”

Once the energy minimization is complete. For each molecule, measure the angles between the

bonds. Some angles will be repeats (due to symmetry). You only need to record one each of the

angles that are different. Also, record the sequence of atoms used to find the angle. Example:

105.00° H-O-H. Find as many different angles as possible. Not all the spaces in the table on the

data sheet will be filled.



Exercise 2 - Combining Two Molecules
Some of the molecules you want to construct are already made.

Steps:

2 1. Select Build 2> Atoms

2. In the tabbed menu bar, scroll down until you see “MMKit.” There are
three tabs under MMKit. Select the one that looks like a file folder. This
will bring up a list of folders that contain molecules already created. Find
benzene through the sequence Organic = Aromatic = Benzene.mmp.
Click on the file benzene.mmp. Then double click in the construction Figure 9
window to place benzene. Place another benzene right next to the first.

3. Delete the hydrogens on the side of one of the benzenes, close to the
other benzene. Delete the adjacent hydrogens on the second benzene
(figure 9).

4. Click and hold on the red empty bond on one of the benzene molecules

and drag it to the empty bond on the other benzene molecule. Do so for Figure 10
both empty bonds. (figure 10).

5. Click the “Exit Atoms” button.

6. Now, in the tabbed menu, you’ll see a list of all the separate “chunks” or

molecules that you’ve placed. There are two benzenes listed. Click on
one of the benzenes to select that chunk. Select Move = Translate.

Figure 11

Move the benzene molecules so that they’re close enough so that there
is little or no red showing on the bonds (figure 11).

7. Minimize the energy of the structure. Allow the procedure to run until you get a “Done”
message in the message pane below the construction window

Exercise 3 - Using Anchors and Linear Motors

Anchors allow you to hold part of a molecule in place. This is especially important when using a
linear motor. Applying a force to a molecule without anchoring will simple translate the molecule in the
direction of the force. If you build a complicated structure, such as the carbon nanotube switch pictured
below, and neglect to anchor any part of the structure, then when a force is applied, the entire structure
will move.
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Figure 12 — Carbon nanotube switch prototype
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The purpose of the carbon nanotube switch is to study the response of a
carbon nanotube based switch to a simulated electrostatic force. Therefore, the
only part of the structure that should move is the CNT lever. Thus the front of the
base and the back of the structure are anchored. (Look for the black squares on
the back and the base.)

You can create a simple version of this switch by following the below steps. Figure 17
Steps:
= & Untitied
1. Open an new window. (D Nanotube-1
_ 2. Create a carbon nanotube by clicking on the Nanotube button. This will gz:::;mr_z
tancae open a panel in the side menu that will allow you to adjust the properties @ (8] cipboard
of the carbon nanotube. (Figure 13)

3. Adjust Length to read 50 angstroms. The chirality of the carbon Flgure 18
nanotube should be (5,5). Set the Endings to Hydrogen. Ignore the
sections on nanotube distortion and multi-walled nanotubes.

4. Click the green check mark to create the carbon nanotube in the construction window.
5. Rotate the view by ninety degrees to get a side view of the carbon nanotube.
6. Select the Atoms button. In the construction window, click and drag to select the last two or
three rings of carbon atoms on one end of the carbon nanotube. (Figure 14)
4 | 7. Addanchors to the selected atoms by clicking Simulation = Anchors. (Figure 15)
S To the other end of the carbon nanotube, you want to attach a linear motor. Click Build =
Atomes. Click and drag to select the first ring of carbon atoms. (Figure 16)
5 1 9. Click Simulation = Linear Motor to attach a linear motor. A box will pop-up that lets you adjust
Linear .. the linear motor properties. Just click OK to close it. Click Move = Rotate and click and drag the
linear motor until the arrow on it points downward. The arrow now points in the direction that
the force will be applied. (Figure 17).

10. Connect an angle measurement to two hydrogen atoms on the top and bottom of the end with
the anchors on it, and the third connection to a hydrogen atom on the top of the other end of
the carbon nanotube. It should show a roughly 90° angle

11. Save your file. This will be you initial configuration file, so give it a unique name.

¢ 12. Click the green checkmark in the corner of the Construction Window.

13. Now you should be able to view the Parts Menu in the Side Menu window. (Figure 18). This is a
list of all the parts or “chunks” that are in your molecule. There should be three of them listed:
The anchor, the linear motor, and the carbon nanotube. Right-click on the linear motor and
open the properties dialog box.

14. Set the Force to 50,000 pN (50 nN). Click OK to close the dialog box. Choose Save As and save
the file under a different name.

15. Select Simulation = Run Dynamics. The Dynamics dialog box will open. Set the simulation to

500 frames, 10 steps/frame, and temperature at 300 K (this is room temperature.) Click Run
Simulation. Allow the simulation to run to completion.



16.

17.
18.
19.
20.
21.

Once the simulation is complete, you can view the movie by clicking Simulation = Play Movie.
Be sure to rewind the movie before closing the Movie Side Menu. Close the movie side menu.
Save your file.

Open your initial configuration file and Save As a different name.

Run the simulation again, only this time, change the force to 75,000 pN (75 nN). Save the file.
Repeat for a third simulation with the force at 100,000 pN (100 nN). Save the file.

Watch and compare all three movies. Answer the questions on the data sheet.

AFTER COMPLETING THE EXERCISES IN THIS TUTORIAL, PLEASE TURN IN THE
ORIGINAL DATA SHEETS TO YOUR INSTRUCTOR.

If you are interested in learning more about NanoEngineer-1 and how to use it, visit the NE-1

wiki at www.nanoengineer-1.net. In the search box, type “tutorials.” The results will be an

entire list of projects you can build with step by step instruction on how to complete them.



Data Sheet

Exercisel - Building Simple Models and Making Angle Measurements
Fill in the table below. If you run out of room for a molecule, add more rows to the table.

Molecule Angle Atoms Angle Atoms Angle Atoms Angle Atoms

CH,

H-C=C-H

C4Hs

NH3

Cyclobutane with
substituted CH3

HOCH,CH,CH,Br

Exercise 3 - Using Anchors and Linear Motors
Answer the questions on this page and the next and fill in the tables.

What are the initial and final angles for all three simulations? Fill in the table.

Force
Applied
50 nN
75 nN
100 nN

Initial Angle | Final Angle

As you watch the movies, do you notice any stretching of the bonds that show red? If so,
where? Red bonds signify that the bond is being stretched beyond the equilibrium length.



Estimate how much force would be required to achieve a final angle of 45°.

Make a graph of the applied force vs. the change in the angle (A8 = Bfnai — Binitial). Show the
graph below.

Using the graph, predict the value of the force that would result in a final angle of 45°.

By what percentage does this predicted value differ from the estimated value? Show your
calculation for the percent difference.
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